
SBClient

SBClient Release Notes

Version 6.3.0

February 2015
SBC-630-ALL-RN-01



2

SBClient v6.3.0 release notes
Build 5106
Release Date: February 2015
These release notes provide information about enhancements and fixes in SBClient v6.3.0.

Enhancements and fixes in SBClient v6.3.0

The following issues were addressed in this release:

Key Description Component/s

SBXA-3878 In v6.3.0, you can select an SSH communication method in
SBClient to be used by the session to connect your PC to
the host computer. SSH provides a secure way for you to
connect to your U2 host. You cannot use SSH to connect
to server versions prior to v6.3.0. For more information
about SSH with SBClient, see "Overview of SSH" and
"Configuring a session" in Using SBClient, and see "Setting
up communication" in SBClient Getting Started.

Communications /
File Transfer,
SBClient

SBXA-11697 Previously, if a field was extended beyond the character
length specified in the field definition, and then you
attempted to copy the field's contents with Ctrl-C, the
client crashed. This occurred in GUI only. This issue is
resolved in v6.3.0.

SBClient

SBXA-13158 In previous versions, the data transfer subroutine
TU.TO.WORD.MERGE.PRINTER did not work in SBClient
with Office 2007 or later. This issue is fixed in v6.3.0.

SBClient

SBXA-13352 Beginning in v6.2.2, if you had MS Access and Visual Studio
installed as well as SBClient, and then you uninstalled
SBClient, registry keys were incorrectly removed. These
keys were needed by MS Access and Visual Studio. This
issue is fixed in v6.3.0.

Installation /
Configuration,
SBClient

SBXA-13683 In previous versions, if you chose DEMO mode during
SBClient installation and then tried later to update the
license and register it later, you were unable to do so
unless you were running the client as Administrator. With
a fix in v6.3.0, the Client now displays a message detailing
the problem and suggesting you run as Administrator in
order to update the license.

Installation /
Configuration,
SBClient



Rocket SystemBuilder Extensible Architecture 

 

SBClient Legacy Release Notes 
In v6.2.6 and earlier, SBClient release notes were delivered as a .txt file. 

Beginning with v6.3.0, release notes are delivered in a PDF format to match SystemBuilder 
Extensible Architecture release notes. 

The following sections contain legacy SBClient release notes, from v5.5.0 through v6.2.6. The 
legacy release notes have been converted from .txt to PDF, but they are otherwise presented in 
the same format. 



SBClient v6.2.6 Release Notes 

Build 4525 

July 2014 

============================= 

These release notes are divided into the following sections: 

What's New in SBClient v6.2.6 

Operating System Requirements

Data Server Requirements 

Important Notes 

Installation Information 

Currently Supported Communication Protocols 

Currently Supported Terminal Emulations

Fixes in v6.2.6 

Known Problems 

Miscellaneous Information 

What's New in SBClient v6.2.6 

============================= 

** Bug fixes only 

----------------- 

SBClient v6.2.6 contains one bug fix and no new enhancements. For details, 

see "Fixes in v6.2.6" below. 



 

Operating System Requirements 

============================= 

 

Minimum operating system requirements for SBClient v6.2.6 are: 

 

Microsoft Windows Server 2008: R2 Service Pack 1 or later 

Microsoft Windows Server 2012: Standard edition (64-bit) 

Microsoft Windows 7: Professional, Enterprise, or Ultimate edition, 

                     Service Pack 1 or later 

Microsoft Windows 8: Enterprise edition (64-bit) 

 

For information on SBClient and Microsoft Windows Terminal Server, see the 

tech note on this subject at https://u2tc.rocketsoftware.com > Public Tech Notes. 

 

 

Data Server Requirements 

======================== 

 

The minimum data server requirements of the SBClient 3GL Host API are as follows: 

 

UniData 7.1.20 or later on Windows or UNIX 

UniVerse 10.2.3 or later (Pick compatibility) on Windows or UNIX 

UniVerse 10.2.3 or later (Pick compatibility) with National Language Support 

(NLS) on Windows or UNIX 

 

 

Important Notes 

=============== 



 

Notes on User Types for Installing SBClient on Windows 

------------------------------------------------------ 

To install SBClient on Windows, the user must be either an Administrator or 

Power User. 

 

 

Exporting SBClient Settings 

------------------------------ 

 

Existing customers who installed SBClient 6.0.1 or earlier may have 

session configurations, scripts, phone books, toolbars, and Smart Query 

definitions that can be used in SBClient 6.0.2 or later. To save settings 

from SBClient 6.0.1 or earlier, you can export the settings to a file before 

installing SBClient 6.0.2 or later. After installing the latest version of 

SBClient, you can then import the files containing settings that you saved. 

For instructions, see Chapter 2, "Installing SBClient on a Standalone PC" in 

SBClient Getting Started. 

 

 

GUI Tokens and UNIX STTY Settings 

--------------------------------- 

When installing the bootstrap for the Host Library, setting the UNIX kill 

character to any character less than 127 can cause the installation to fail. 

 

The LNEXT token (usually set to 'Ctrl - V') is a literal next character on SVR4 

and 4.4+BSD UNIX. The LNEXT character is recognized on input in Extended mode 

only; it causes any special meaning of the next character to be ignored. The LNEXT 

character is discarded when processed, but the next character entered is passed to 



the process. The LNEXT character is in conflict with one of the internal SBClient 

tokens. If it is enabled, you need to turn it off. You can turn off Extended mode 

by entering 'stty -iexten'.  

 

SBClient makes extensive use of ASCII characters 1 and 2 (Ctrl-A and Ctrl-B) 

for communications protocols. You should ensure that these are not used by UNIX or 

terminal server line settings. 

 

7-bit communications utilities on Unix, such as "rlogin", should not be used in 

conjunction with SBClient. 

 

 

Euro Character 

-------------- 

The Euro character is not included in the SB or System Builder font. The reason 

is that there is no international consensus as to where the character should be 

positioned within an OEM. IBM has decided to place the character at position 159, 

while Xerox has chosen position 186, Microsoft has chosen position 128, and 

Monotype and many other companies have chosen position 168. 

 

When communicating with a UniData or UniVerse etc host, the host in most cases 

uses an OEM character set. Since most Windows fonts are ANSI fonts, SBClient must 

do an OEM-to-ANSI conversion on data coming from the host and an ANSI-to-OEM 

conversion on data going to the host. SBClient calls the standard Windows API to 

do the conversions. The problem is that the Windows API knows nothing about the 

Euro or its OEM position.   

 

If the user is using the SB or System Builder font, SBClient does not perform a 

conversion when communicating with an OEM host because these are already OEM 



fonts. This means that if the application on the host sends CHAR(159), the IBM 

Euro position, and System Builder font uses the Xerox position 186, the display 

is incorrect.   

 

Therefore, SBClient needs to know the position of Euro character according to the 

host and this has to match the position in the SB or System Builder font. If the 

user is using an ANSI font, such as Courier New (with Euro support), SBClient 

needs to perform a conversion, but the standard Windows conversion will not work.   

 

Currently, two solutions are available: 

 

- If the Euro character is required, download Microsoft's new Courier font (or a 

similar font from another vendor), and select it from the Setup/Fonts window. 

A translation table should be set up. (For further information, see the section on 

the new translation functionality in the Using SBClient manual.) The table should 

specify ANSI-to-OEM mappings in the [output] section and OEM-to-ANSI mappings in 

the [input] section. If using a Microsoft font, the host's Euro character position 

should be mapped to CHAR(128) in the [input] section of the translation table and 

vice versa in the [output] section. You can map an Alt or Ctrl key to CHAR(128) in 

the [display] section so the user can enter the character from any keyboard. 

 

- For detailed information on a second workaround solution for display of European 

currency symbols, contact Global Technical Support. 

 

 

Installation Information 

======================== 

 

During installation of SBClient, files are copied to the directory chosen by the 



user. The default installation folder is C:\U2\SBClient6. Some files are copied to 

other locations, as listed below. 

 

The following SBClient files are copied to the Windows directory if the 

files do not exist or if older versions of the files are found in the target 

directory: 

 

   MFC and C runtime DLLs, via Microsoft merge modules mfc100.dll, mfc100u.dll, 

    mfcm100.dll, mfcm100u.dll, msvcp100.dll, and msvcr100.dll 

   mscal.ocx  

   mschart.ocx 

   mscomctl.ocx 

   comctl32.ocx 

   comdlg32.ocx 

   many2pdfx.ocx 

   edocenginex.ocx 

   grid32.ocx 

   SBClientScriptControl.ocx 

   SBpvdt60.ocx 

   wwtree.ocx 

   u2libeay32097e.dll 

   u2licn.dll 

   u2ssleay32097e.dll 

   uniwincert.dll 

 

The following fonts are installed to the system: 

   System Builder=SB.FON 

   SB Font (True Type)=SB.TTF 

 



 

Currently Supported Communication Protocols 

=========================================== 

 

Connection by standard serial line is supported with a variety of COM 

ports and baud rates. The only network communication stack supported is 

TCP/IP through the Windows Socket (Winsock) interface. 

 

 

Currently Supported Terminal Emulations 

======================================= 

 

SBClient currently provides support for the following terminals: 

   

   ANSI 

   VT52      

   VT100     

   VT220 

   VT320    use VT220 with "ANSI color" on 

   Wyse 50  use Wyse 60 with "Embedded" on 

   Wyse 60 

   Wyse 120 

 

An SB+ mode is available for all the above terminal types. Set this mode 

when using SB/XA Application Server to enable a number of subtle 

functionality differences. To set the SB+ mode, open the SBClient Setup 

menu. In the Terminal Setup option, select the SB+ Mode check box. We 

recommend using VT220 when communicating with SB/XA for optimal performance. 

 



Fixes in v6.2.6 - July 2014 

=========================== 

- From SBClient version 6.2.4 through 6.2.5, if you set the Auto Extend Field Length flag to No, the 
change did not take effect in GUI mode. Auto extend was not disabled as it should have been. This issue 
is resolved in v6.2.6.  SBXA-13383 

Fixes in v6.2.5 - May 2014 

=========================== 

- In previous versions, SBClient crashed if you chose File>Save Configuration As and then clicked Cancel 
on the subsequent dialog box. If you then chose File>Exit All, the client crashed. This issue is resolved in 
v6.2.5. SBXA-13023 

Fixes in v6.2.4 - March 2014 

=========================== 

- In previous versions of the GUI client, using SETATTR to disable Bitmap images failed to dim the 
images. This issue is resolved in v6.2.4. SBXA-12019 

- Using the /PD.L > Data Transfer DOS to SB+ process to transfer a file failed in previous versions if 

the file being transferred was empty. This issue is resolved with a fix in v6.2.4. SBXA-12232 

- In previous versions, creating users with null passwords led to subsequent problems when those users 
tried to run processes such as /SEC.USER.SETUP or any other process that called the SH.VERIFY.USER 
routine. This issue is resolved in v6.2.4. SBXA-12276 

- In versions 6.2.2 and 6.2.3, language translation for menus sometimes failed in GUI mode in SBClient as 
well as the XUI clients. If there was no Type 5 menu to regenerate, translated menus did not properly 
display the translated text in GUI or XUI. This issue is fixed in v6.2.4. SBXA-12328 



- In previous versions, using the /MESSAGE process to send a message, with the Alert Recipients 
Immediately option selected, improperly caused another process to start on the Windows server. This 
problem was specific only to a UniData-on-Windows platform. The issue is resolved in v6.2.4. SBXA-
12531 

 

- Grids were not used when they should have been in previous versions under certain circumstances. If 
the "Use Grids for Multivalued Fields" flag at the screen level was set to use grids, the grids should have 
been used even if flags at the SB Control Parameters level and HK.CONTROL level were set to not use 
grids. The screen-level flag should have overridden the others, but it did not in previous versions. This 
issue is fixed in v6.2.4. SBXA-12541 

 

 

Fixes in v6.2.3 - December 2013 

=========================== 

 

- In recent versions, SBClient did not properly save the Join Lines and Append CR settings on the 
clipboard setup. This issue is resolved in v6.2.3. SBXA-4881 

 

- In previous versions, SBClient crashed because of a memory leak when screens were repeatedly 
displayed. This issue has been resolved in v6.2.3. SBXA-10731 

 

 

Fixes in v6.2.2 - June 2013 

=========================== 

 

- SBClient DLLs are copyright-branded with both the date and company name in 

v6.2.2. SBXA-10277 

 

- When using Wyse terminal emulation in SBClient, screen attributes were lost 

after saving and restoring the screen. A fix resolves this problem in v6.2.2. 

SBXA-10731 

 



 

Enhancements and Fixes in v6.2.1 - February 2013 

================================================ 

 

_ At v6.2.1, SBClient is certified to run on Microsoft Windows 8. SBXA-9334 

 

_ At v6.2.1, SBClient is also certified to run on Microsoft Windows Server 2012. 

SBXA-9979 

 

- A change to the processing of SYSTEM(14) and INPUT(-1) in UniBasic code at 

UniData V7.2.12 caused SBClient file transfers to fail. Additional changes were 

made at UniData V7.3.3 to support SBClient file transfer processes, and SBClient 

v6.2.1 has been modified to run on all versions of UniData. 

 

If you experience this problem in earlier versions of SBClient with UniData 

V7.2.12, you can either upgrade to UniData V7.3.3, downgrade to an earlier 

version of UniData, or refer to Tech Note SBXA-9449 for a resolution. 

SBXA-10019  

 

 

Enhancements and Fixes in v6.2.0 - October 2012 

=============================================== 

 

_ In SBClient, the SBZ transfer protocol failed in binary and hex modes in 

the UniData edition on Windows. This issue was resolved in v6.2.0. SBXA-3262 

 

_ A 64-bit version of the SBXAMAPIBridge component is provided to support 

TU.MAPI messaging with the 64-bit version of Microsoft Office in SBClient. The 

SBXAMAPIBridge64.msi program file is available in the SB/XA product download 



directory. SBXA-4572 

 

_ In previous versions, an ActiveX control caused SBClient to fail. This issue 

is resolved in v6.2.0. SBXA-7999 

 

_ In GUI mode, if you pressed F3 in a numeric field with a comma separator, 

the values were displayed incorrectly as zeroes. A fix resolves this problem 

in v6.2.0. SBXA-8294 

 

_ The SBClient v6.2.0 splash screen and and launchpad are rebranded with the 

purple graphic for Database Servers and Tools. SBXA-8398 

 

_ When using the GUI text editor (/GUI.TEXT.ED) in GUI mode, if a memo field 

contained 465 characters or more, char(10) was not inserted between rows. The 

code has been amended to correct this issue in v6.2.0. SBXA-8547 

 

_ The GUI text editor (/GUI.TEXT.ED) failed in GUI mode when value marks were 

inserted in F3 intuitive help. The code has been amended to prevent this 

problem in GUI mode. SBXA-8833 

 

_ In SBClient, a toggle in a grid returned an error if it used a table 

definition with three different values in the internal code, display text, 

and input code, and if Allow NULL was set to N in a validation. Both client 

and server code were amended to prevent this error condition in v6.2.0. 

SBXA-8893 

 

_ In SBClient running on Microsoft Windows 7 or Windows 2008 x64, selecting 

View > Clipboard Viewer returned the error “CreateProcess 'clipbrd.exe' 

failed. error(2) - file not found.” The clipbrd.exe file is not supplied with 



Microsoft Windows 7 or Windows 2008, so the View > Clipboard Viewer option has 

been removed from the SBClient menu. As part of this change, a paragraph 

regarding the Clipboard Viewer has been deleted from Chapter 1, “Introduction 

to SBClient,” in the Using SBClient manual. SBXA-9108 

 

_ The SBClient device licensing dynamic link library (DLL) has been updated 

to version 3.2.1.0. SBXA-9138 

 

_ Check boxes (toggles) on a subscreen did not work correctly in a multivalue 

group in GUI mode. This issue is resolved in v6.2.0. SBXA-9218 

 

 

Fixes in v6.1.3 - June 2012 

=========================== 

 

- In v6.0.0 and later, SBClient failed when attempting to print a string to the 

auxiliary (Aux) device when the length of the string was 8192 characters (or any 

multiple of 4096 characters). The code has been changed to append the null value 

to such strings, correcting this problem in v6.1.3. SBXA-1850 

 

- In v6.1.2, deleting the default network configuration profile resulted 

in a “Default Modem has changed” error. A section of code that checks the 

deleted item has been amended, preventing this error in v6.1.3. SBXA-5281 

 

- With terminal emulation set to Wyse 50, SBClient displayed selections in 

reverse video beyond the defined boundaries. This behavior has been corrected. 

SBXA-5343 

 

- On computers running Windows XP, rolling the mouse over the SBClient toolbar 



displayed an empty box, sometimes consuming half of the desktop display area. 

This was due to failure of a system call to find the correct font in which to 

display hover help, which then caused the program to select a random font 

family/size to determine the size of the hover help window. The program has 

been amended in v6.1.3, and the hover help window is displayed as designed. 

SBXA-7871 

 

- When running a program from the command line to display text in reverse video 

on an HP Itanium server, the reverse video was not turned off correctly and the 

next menu option on the selected menu was displayed in reverse video in SBClient 

with Wyse 50/60 emulations. The code has been amended to fix this problem in 

v6.1.3. SBXA-8121 

 

- A call to TU.PC.UPLOAD caused SBClient to fail. Revisions to the file 

transfer program corrects this problem in v6.1.3. SBXA-8256 

 

- The msmapi32.ocx Active X control that supports MAPI in SBClient was not 

present on the product CD image in v6.1.2. MAPI did not work unless Active X 

was already present on the client computer. The msmapi32.ocx file has been 

re-added to the build scripts in v6.1.3. SBXA-8449 

 

 

Fixes in v6.1.2 - February 2012 

=============================== 

 

- When running SBClient in GUI mode on the 32-bit version of Windows 7 or Vista 

with the Aero theme, menu bars disappeared and then reappeared after clicking 

or rolling the mouse over the area or running another process. This issue has 

been resolved in version 6.1.2. SBXA-4583 



 

- Using clear-to-end-of-line with reverse video did not work with Wyse 50 

terminal emulation in SBClient. A fix was applied to the Wyse 50 emulation code 

in version 6.1.2, and clear-to-end-of-line functionality now works as expected. 

SBXA-4923 

 

- When running SBClient on Windows 7, function keys were not displayed on 

screens if the action bar wrapped to a second line. A code change resolves 

this issue in version 6.1.2. SBXA-5270 

 

 

Fixes in v6.1.1 - October 2011 

============================== 

 

- In previous versions, TU.LAUNCH.APP was looking for a key in the Registry 

that is no longer there. This subroutine has been changed so it does not look 

for a nonexistent key. SBXA-4050 

 

- With terminal emulation set to Wyse 50, SBClient displayed Esc (escape) 

characters as a black box. The escape character should be displayed in the same 

color as the background color definition. This has been fixed in version 6.1.1. 

SBXA-4151   

 

 

Fixes in v6.1.0 - June 2011 

=========================== 

 

- In versions 6.0.4 and later, pressing Shift + function key (such as Shift F7) 

in the controlling multivalued field of a CAIDE grid invoked the same event as 



pressing the function key alone. This issue has been corrected in version 6.1.0 

so that the Shift key sends the proper event. SBXA-3646 

 

_ When a selection process (/PD.S) contained a field that was defined as 

numeric and was not left-justified, SBClient returned an unhandled exception 

error and became unresponsive if nonnumeric data was displayed in the field. 

A code fix prevents this problem in version 6.1.0, and the client can now 

handle the display of nonnumeric data in a numeric field that is left- or 

right-justified. SBXA-4357    

 

 

No Fixes in v6.0.5 - January 2011 

================================= 

 

- There are no fixes or enhancements in SBClient 6.0.5. The version 

number has been incremented, and SBClient 6.0.5 has been tested for 

compatibility with SB/XA Application Server 6.0.5.  

 

 

Fixes in v6.0.4 - December 2010 

=============================== 

 

 

- When deleting multiple Classic sessions, a delete confirmation dialog box is 

displayed. A spelling error in this dialog box has been corrected. 

 SBXA-3409 

 

- In certain circumstances, SBClient returned a file access error during 

installation: "The following error occurred on the file 



C:\Windows\System32\mfc40.dll Access Denied (0x5)." The installation code has 

been fixed to prevent this error in version 6.0.4. SBXA-3457 

 

- Smart Query (/SMART.QUERY) processes did not display all field definition 

records, skipping those with a value of D in F1. The Smart Query code has 

been amended, and all field definition  records are returned in version 6.0.4. 

SBXA-3515 

 

- When using TU.PC.DOWNLOAD to download a file to the PC in tab-separated 

values format, extra bytes were inserted at the end of the second to last 

record, and were displayed as extra spaces. The code has been amended in 

version 6.0.4 so the subroutine downloads values properly in tab-separated 

values format. SBXA-3654 

 

- In previous versions, the file transfer process did not support use of a 

network path starting with either ""\\"" or ""//"" in file download or 

upload operations. The method for resolving environment variables has been 

changed in version 6.0.4 to recognize and handle these network path 

characters. SBXA-3676 

 

 

Fixes in v6.0.3 - June 2010 

=========================== 

 

- The default installation path was changed from C:\IBM to C:\U2, and "IBM" 

was removed from other path names in the product in version 6.0.2. Accordingly, 

the path names have been changed in text and in screen shots throughout the 

version 6.0.3 SBClient manuals. Note that the SBClient Getting Started guide 

still contains instructions for removing older versions of the product in its 



C:\IBM location. 40776*USA 

 

 

Fixes in v6.0.2 - May 2010 

========================== 

 

- In previous versions, TU.TO.EXCEL did not function with non-English 

versions of Microsoft Excel. Support has been added in version 6.0.2 

for SBClient only as follows: If you use more than one language version 

of Excel, you can create a version of EXCEL.MACRO for each language (such 

as EXCEL.MACRO.FR or EXCEL.MACRO.SP) and store it in TUDEFN. TU.TO.EXCEL 

will then select the required version of the EXCEL.MACRO. Note that 

SB/XA Browser Client and SB/XA Rich Client do not yet provide support 

for Microsoft Office products. 11832*USA  

 

-  In SBClient 6.0.2 in GUI mode, the Logto Another Account screen 

(/LOGTO), System Control Record (/HK.CONTROL), and other screens were 

displayed in character mode. A code fix corrects this problem in version 

6.0.2. 12824*USA 

 

-  Enhancements have been made in version 6.0.2 to remove SBClient's 

dependencies on the BTrieve database engine. 37694*USA 

 

-  In version 6.0.1, the Control Panel > Add or Remove Programs > 

SBClient uninstall program did not remove SBClient. Instead, it attempted 

to upgrade SBClient. This issue has been fixed in version 6.0.2 and the 

uninstall program works as designed. 41593*UK 

 

 



Fixes in v6.0.1 - November 2009 

=============================== 

 

- If a code table is updated by an expression and the expression supplied   

value with leading zeros, the leading zeros were suppressed. This has been 

fixed. 11190*USA  

 

- In selection grids displayed in GUI mode, changing the sort order of the 

records multiple times corrupted the return value, so multivalues in @VALUE 

were left empty. A fix has been implemented to prevent this problem in version 

6.0.1. 11488*USA 

 

 

Fix in v6.0.0 - August 2008 

=========================== 

 

- In versions 5.3.4 and later, downloading a file using the Network Copy 

protocol failed if the process took more than two minutes. This issue has 

been resolved in SBClient 6.0.0. 10832*USA 

 

 

Fixes in v5.5.3 - February 2012 

=============================== 

 

- When running SBClient on Windows 7, function keys were not displayed on 

screens if the action bar wrapped to a second line. A code change resolves 

this issue in version 5.5.3. SBXA-4387, SBXA-4952 

 

- Installing SBClient 5.5.1 or 5.5.2 as an upgrade resulted in a license error, 



"Your evaluation version is expired." This issue stemmed from a change to 

Registry keys after version 5.5.0. The installation program has been changed 

to detect and update Registry keys from version 5.5.0, preventing this problem 

with installing version 5.5.3 or later as an upgrade. SBXA-5061 

 

- When registering SBClient during installation or later as a separate task, 

if the user clicked the Demo Version button, SBClient displayed a license error, 

"Your evaluation version is expired." This problem is attributed to the same 

Registry key issue as SBXA-5061, and a related fix prevents this registration 

error in version 5.5.3. SBXA-5224 

   

 

Fixes in v5.5.2 - December 2011 

====================================== 

 

- When running SBClient in GUI mode on the 32-bit version of Windows 7 or Vista 

with the Aero theme, menu bars disappeared and then reappeared after clicking 

or rolling the mouse over the area or running another process. A code fix for 

SBXA-3453 was implemented in version 5.5.0, but this fix caused an unintended 

focus problem that could result in SBClient flickering and becoming unresponsive. 

The focus problem was addressed in version 5.5.2, and after an additional code 

change was implemented, both the menu issue and the focus issue are resolved. 

SBXA-4583 

 

 

Enhancements and Fixes in v5.5.1 - November 2011 

================================================ 

 

- In previous versions, TU.LAUNCH.APP was looking for a key in the Registry 



that is no longer there. This subroutine has been changed so it does not look 

for a nonexistent key. SBXA-4050 

- With terminal emulation set to Wyse 50, SBClient displayed the Esc (escape) 

characters as a black box. The escape character should be displayed in the same 

color as the background color definition. This has been fixed in version 5.5.1. 

SBXA-4151   

- New installations and upgrades to SBClient 5.5.1 require entering a 5.5.1 

authorization key. The 5.5.1 authorization key cannot be used to authorize 

SBClient 5.5.0 or earlier versions. SBXA-4325 

- At version 5.5.1, the Registry keys for SBClient have been changed as follows: 

  ..\ROCKET SOFTWARE\SBCLIENT has been changed to ..\ROCKET SOFTWARE\SBC5\SBCLIENT 

  ..\ROCKET SOFTWARE\Runtime has been changed to .. ROCKET\SOFTWARE\SBC5\RUNTIME 

SBXA-4520 

- The DEMOBP file has been added in SB.DEFN at version 5.5.1. SBXA-4641 

Enhancements and Fixes in v5.5.0 - September 2010 

================================================= 

-  In version 5.4.4, the Control Panel > Add or Remove Programs > 

SBClient uninstall program did not remove SBClient. Instead, it attempted 

to upgrade SBClient. This issue has been fixed in version 5.5.0 and the 

uninstall program works as designed. SBXA-334 

- The default installation path was changed from C:\IBM to C:\U2, and "IBM" 



was removed from other path names in the product in version 5.5.0. Accordingly, 

the path names have been changed in text and in screen shots throughout the 

version 5.5.0 SBClient manuals. SBXA-438 

- In selection grids displayed in GUI mode, changing the sort order of the 

records multiple times corrupted the return value, so multivalues in @VALUE 

were left empty. A fix has been implemented to prevent this problem in version 

5.5.0. SBXA-1268 

- In previous versions, TU.TO.EXCEL did not function with non-English 

versions of Microsoft Excel. Support has been added in version 5.5.0 

in SBClient as follows: If you use more than one language version 

of Excel, you can create a version of EXCEL.MACRO for each language (such 

as EXCEL.MACRO.FR or EXCEL.MACRO.SP) and store it in TUDEFN. TU.TO.EXCEL 

will then select the required version of the EXCEL.MACRO. SBXA-1340 

- The SBZ file transfer protocol failed when attempting to transfer data from 

multilevel files in version 5.2.4 and later. This issue has been resolved in 

version 5.5.0. SBXA-1410  

- The shape and blink properties of the cursor can be set in character mode only. 

In GUI mode, Windows properties are applied. This limitation is noted in Chapter 

2, "Configuring a Session," in Using SBClient. SBXA-1863 

- At version 5.5.0, the SBClient silent installation program has been modified 

to check for Administrator privileges, and, if absent, for Elevated privileges. 

The silent installation can be run with either of these privileges. SBXA-1920  

- When installing earlier versions of SBClient on Windows Vista, 



the operating system displayed an unknown publisher warning. In version 

5.5.0, the SBClient installation program has been signed with the Rocket 

Software certificate, and the warning is no longer displayed. SBXA-2545 

- When deleting multiple Classic session configurations in SBClient, the 

dialog box confirming the deletion contained a spelling error. The spelling of 

"cofigurations" has been corrected to "configurations". SBXA-2560  

- In versions 5.3.4 and later, downloading a file using the Network Copy 

protocol failed if the process took more than two minutes. This issue has 

been resolved in SBClient 5.5.0. SBXA-3025 

- In previous versions of SBClient, GUI screens were not downloaded 

when performing file transfers using the Network Copy protocol on Windows 

Vista. This issue has been addressed so file transfers download GUI data 

properly in Network Copy mode. SBXA-3061 

- If a code table is updated by an expression and the expression supplied   

value with leading zeros, the leading zeros were suppressed. This has been 

fixed. SBXA-3290 

- Enhancements have been made in version 5.5.0 to remove SBClient's 

dependencies on the BTrieve database engine. Due to the change in file 

format, you may want to save settings from SBClient 5.4.4 or earlier. For 

further information, see the section "Exporting SBClient Settings" above. 

SBXA-3436 

- When running SBClient in GUI mode on Windows 7 or Vista with the Aero theme, 

menu bars disappeared and then reappeared after clicking or rolling the mouse 



over the area or running another process. A code fix has been implemented in 

version 5.5.0, and menus are displayed normally. SBXA-3453  

Known Problems 

============ 

- Cursor Properties Cannot Be Set in GUI Mode 

The shape and blink properties of the cursor can be set in character mode 

only. In GUI mode, Windows properties are applied. This limitation is noted 

in Chapter 2, "Configuring a Session," in Using SBClient. 9537*UK 

- Limitation of Secure File Transfers through SSL 

SSL provides secure file transfers only if you use the SBZ file transfer 

type. Other file transfer types do not support SSL functionality. Even if 

SSL is enabled for the session, file transfers with FTP or Network Copy 

are not secure. Notes have been added in the Using SBClient manual. 

34290*USA and 34352*USA 

- Long Numbers Display Incorrectly in GUI ListView Mode 

Due to limitations of ActiveX controls, long numbers are truncated or padded 

with zeros, or digits are overwritten in GUI ListView mode. 7789*USA 

- Problem with Deleting User Environment Variables 

When attempting to delete a user environment variable, the user 

highlights the variable and clicks the Delete button. The variable is 

deleted from the display; however, the variable remains in the sbopen.ini 

file. This issue will be addressed in a future version. 5345*USA 



- Issue with Running SBClient on Dual Monitors 

When running SBClient in GUI mode on a system enabled for dual monitors 

with SB+ MAINWIN running on the secondary monitor, SB+ screens and dialog 

boxes are displayed in the main monitor. This behavior does not comply 

with Windows standards, which specify that the program remember the 

monitor on which the screen was last displayed. 34167*USA 

 

- Message Text in Deleting Multiple Configurations 

When deleting multiple SBClient configurations, the confirmation message 

is the same as that displayed when deleting a single configuration. 

34798*USA 

 

- Pressing ESC in Delete Confirmation Dialog Box Executes the Deletion 

Regardless of whether the OK or Cancel button has focus in a delete 

confirmation dialog box, if you press ESC or click the Close button 

(the X in the upper right corner of the dialog box), the deletion is 

executed.  34799*USA 

 

- Date Fields Sorted as String 

Date fields are sorted as strings in list view in GUI mode. This is a known 

issue with GUI mode that will be addressed in a future version. 4249*USA 

 

- SBClient Does Not Support Roaming User Profiles 

The user profile is stored on the C: drive in Documents and Settings on the 

user's computer, so roaming user profiles are not supported. 4023*USA       

 

- Printing PCL or Binary Files Using AUX Printing 

Users requested the ability to print a PCL file using AUX printing. However, 

the AUX printing feature is not designed to print PCL or binary files. The 



original idea of AUX printing was that whatever would normally be displayed on 

the terminal screen would be diverted to the printer. Based on this principle, 

you would never have the ability to dump a binary file to your terminal screen 

because it does not handle binary data. The same holds true of terminal emulation: 

SBClient cannot handle binary data in this mode. 

Workaround solution: 

Transport the PCL file to the client and print from there without going through 

the AUX printing interface and emulation. 5461*USA 

 

- SBClient Does Not Support All Character Sets 

Although Windows 2000, Windows XP, and Windows 2003 provide full multilanguage 

support, SBClient supports only the English and Western European character sets 

on these operating systems. 4290*USA  

 

 

Miscellaneous Information 

========================= 

 

- UniVerse Case Inversion 

When logging in to a UniVerse account, UniVerse inverts the current case of the 

characters. This can cause problems with the 3GL Host API communicating with the 

client. We suggest that you turn off case inverting in a login proc/paragraph. 

 

- The Wyse terminal emulations use the Wyse ANSI keyboard.  If you want to 

emulate the Wyse EPC keyboard remap, using the Terminal Configuration>Key 

Mapping dialog box to remap the following keys: 

   Insert to (27)r 

   Shift+Insert to (27)q 

   Delete to (127) 



   Shift+Tab to (27)I 

 

- Input Buffer Size 

On some platforms, when data is sent to the host where the data is larger than 

the input buffer, the system may "hang".  In most cases SBClient knows the  

correct size of the input buffer and will break the data into small enough  

blocks, however there are some cases where SBClient only finds out the size  

after the data transfer has already failed.  SBClient always tries to re-send  

the data but on some platforms it is too late.  If you experience problems  

when uploading the host code or doing DDE transfers, set the value of the  

input buffer to an actual value rather than the default of Auto.  If the  

system hangs again, try a smaller value.  Keep trying smaller values until the 

system works correctly. 

 

- GUI Watchdog Timer 

When in GUI mode, SBClient periodically sends a sequence to the host to check 

that the host is still 'alive'. If the host fails to return a sequence within 

a certain length of time, SBClient knows that it is not running and displays a 

dialog box to inform the user. The frequency at which SBClient checks the host 

is called the watchdog timer. The timer can be configured in the GUI parameters 

setup screen. The default value is 0 seconds (the feature is turned off). A 

second parameter controls the timeout period, or the length of time to wait after 

sending an escape sequence to the host before displaying a dialog box. You can 

also set this value from the GUI parameters screen. The default timeout period is 

0 seconds (the feature is turned off). Setting the above values to 0 switches off 

the watchdog timer.   

 

- Network Copy 

If you are using Network Copy between multiple NT domains (for example, the domain 



you need to connect to is different from the one which you logged in to), we 

recommend that you create a drive mapping to the TEMP directory on the Windows NT 

server. See the online help for instructions. Mapping a drive will avoid problems 

with authentication when connecting to this domain. Note: This drive mapping 

should always be reconnected at login time. 
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Product version: Version 6.3.0

Copyright
© Rocket Software, Inc. or its affiliates 1989-2015. All Rights Reserved.

Trademarks

Rocket is a registered trademark of Rocket Software, Inc. For a list of Rocket registered trademarks go
to: www.rocketsoftware.com/about/legal. All other products or services mentioned in this document
may be covered by the trademarks, service marks, or product names of their respective owners.

Examples

This information might contain examples of data and reports. The examples include the names of
individuals, companies, brands, and products. All of these names are fictitious and any similarity to
the names and addresses used by an actual business enterprise is entirely coincidental.

License agreement

This software and the associated documentation are proprietary and confidential to Rocket Software,
Inc. or its affiliates, are furnished under license, and may be used and copied only in accordance with
the terms of such license.

Note:  This product may contain encryption technology. Many countries prohibit or restrict the
use, import, or export of encryption technologies, and current use, import, and export regulations
should be followed when exporting this product.

http://www.rocketsoftware.com/about/legal
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Corporate information
Rocket Software, Inc. develops enterprise infrastructure products in four key areas: storage, networks,
and compliance; database servers and tools; business information and analytics; and application
development, integration, and modernization.

Website: www.rocketsoftware.com

Rocket Global Headquarters
77 4th Avenue, Suite 100
Waltham, MA 02451-1468
USA

To contact Rocket Software by telephone for any reason, including obtaining pre-sales information
and technical support, use one of the following telephone numbers.

Country Toll-free telephone number

United States 1-855-577-4323
Australia 1-800-823-405
Belgium 0800-266-65
Canada 1-855-577-4323
China 800-720-1170
France 0800-180-0882
Germany 08-05-08-05-62
Italy 800-878-295
Japan 0800-170-5464
Netherlands 0-800-022-2961
New Zealand 0800-003210
South Africa 0-800-980-818
United Kingdom 0800-520-0439

Contacting Technical Support

The Rocket Customer Portal is the primary method of obtaining support. If you have current
support and maintenance agreements with Rocket Software, you can access the Rocket Customer
Portal and report a problem, download an update, or find answers to in the U2 Knowledgebase.
To log in to the Rocket Customer Portal or to request a Rocket Customer Portal account, go to
www.rocketsoftware.com/support.

In addition to using the Rocket Customer Portal to obtain support, you can send an email to
u2support@rocketsoftware.com or use one of the following telephone numbers.

Country Telephone number

North America +1 800 729 3553
United Kingdom/France +44 (0) 800 773 771 or +44 (0) 20 8867 3691
Europe/Africa +44 (0) 20 8867 3692
Australia +1 800 707 703 or +61 (0) 29412 5450
New Zealand +0800 505 515

http://www.rocketsoftware.com
http://www.rocketsoftware.com/support
mailto:u2support@rocketsoftware.com
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